
Chapter 1: Customizing PowerPoint

In This Chapter
✓ Personalizing the Ribbon

✓ Changing around the Quick Access toolbar

✓ Choosing what appears on the status bar

✓ Choosing a PowerPoint color scheme

This chapter describes a handful of things you can do to customize 
PowerPoint. Don’t be afraid to make like a software developer and 

change the program to your liking. Many people are wary of retooling 
PowerPoint, but you can always reverse the changes you make if you don’t 
like them, as I explain throughout this chapter.

This chapter shows how to customize the Ribbon and put your favorite 
button commands on the Quick Access toolbar. Instead of fishing around 
for your favorite commands, you can assemble them on the Ribbon or 
Quick Access toolbar and locate them right away. You also discover how 
to change around the status bar and dress up PowerPoint in a new set of 
clothes.

Customizing the Ribbon
As you surely know by now, the Ribbon is the stretch of ground across the 
top of PowerPoint. The Ribbon is composed of tabs. On each tab, commands 
are arranged by group. To undertake a task, you visit a tab on the Ribbon, find 
the group with the command you want, and choose the command. If you are 
so inclined, you can customize the Ribbon. You can place the tabs and com-
mands you know and love where you want to find them on the Ribbon. And 
you can remove tabs and commands that aren’t useful to you.

To customize the Ribbon, open the Customize Ribbon tab of the PowerPoint 
Options dialog box with one of these techniques:

  ✦ On the File tab, choose Options. In the PowerPoint Options dialog box, 
go to the Customize Ribbon category.

 ✦ Right-click a tab or button on the Ribbon and choose Customize the 
Ribbon.
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514 Customizing the Ribbon

You see commands for customizing the Ribbon, as shown in Figure 1-1. The 
right side of the dialog box (“Customize the Ribbon”) lists the names of tabs, 
groups within tabs, and commands within groups that are currently on the 
Ribbon. To customize the Ribbon, you arrange the right side of the dialog 
box to your liking. You list the tabs, groups, and commands that you want 
for the Ribbon on the right side of the dialog box.

 

Figure 1-1: 
Starting 
in the 
Customize 
Ribbon 
category 
of the 
PowerPoint 
Options 
dialog box, 
you can 
customize 
the Ribbon.

 

Display tab, group, and command names Tab name Group name Command names

Add and remove tabs, groups, and commands

Restore the original settings

Change the order of tabs

The left side of the dialog box (“Choose Commands From”) presents every 
tab, group, and command in PowerPoint. To customize the Ribbon, you 
select a tab, group, or command on the left side of the dialog box and move 
it to the right side.

Keep reading to find out how to display tabs, groups, and commands in the 
PowerPoint Options dialog box and how to do all else that pertains to cus-
tomizing the Ribbon. In case you make a hash of the Ribbon, you also find 
instructions for restoring the Ribbon to its original state.
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515Customizing the Ribbon

Displaying and selecting tab, 
group, and command names
To customize the Ribbon, you need to display and select tab names, group 
names, and command names in the PowerPoint Options dialog box (refer 
to Figure 1-1). Start by opening the drop-down lists and choosing a display 
option:

 ✦ Choose Commands From: Choose an option to locate the tab, group, 
or command you want to add to the Ribbon. For example, choose 
All Commands to see an alphabetical list of all the commands in 
PowerPoint; choose Main Tabs to see a list of tabs.

 ✦ Customize the Ribbon: Choose an option to display the names of all 
tabs, main tabs, or tool tabs. Tool tabs are the context-sensitive tabs 
that appear after you insert or click something. For example, the Table 
Tools tabs appear when you construct tables.

After you choose display options on the drop-down lists, display the names 
of groups and commands (refer to Figure 1-1):

 ✦ Displaying group names: Click a plus sign icon next to a tab name to see 
the names of its groups. You can click the minus sign icon to fold group 
names back into a tab name.

 ✦ Displaying command names in groups: Click the plus sign icon next to a 
group name to see the names of its commands. You can click the minus 
sign icon to collapse command names.

After you display the tab, group, or command name, click to select it.

Moving tabs and groups on the Ribbon
To change the order of tabs on the Ribbon or groups on a tab, go to the 
Customize Ribbon category of the PowerPoint Options dialog box (refer 
to Figure 1-1) and select the name of a tab or group on the right side of the 
dialog box. Then click the Move Up or Move Down button. Click these but-
tons as necessary until tabs or groups are in the order that you see fit.

 Be careful about moving groups by clicking the Move Up or Move Down 
button. Clicking these buttons too many times can move a group to a differ-
ent tab on the Ribbon.

Adding, removing, and renaming 
tabs, groups, and commands
In the PowerPoint Options dialog box (refer to Figure 1-1), display and select 
the tab, group, or command you want to add, remove, or rename. Then pro-
ceed to add, remove, or rename it. (Earlier in this chapter, “Displaying and 
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516 Customizing the Ribbon

selecting tab, group, and command names” explains how to display items in 
the PowerPoint Options dialog box.)

You can add commands to groups you created, not to groups that originated 
with PowerPoint.

Adding items to the Ribbon
Follow these steps to add a tab, group, or command to the Ribbon:

 1. On the left side of the Customize Ribbon tab of the PowerPoint Options 
dialog box, select the tab, group, or command you want to add.

  For example, to add the Tables group to the Home tab, select the Tables 
group (under the Insert tab).

 2. On the right side of the dialog box, select the tab or group where you 
want to place the item.

  If you’re adding a tab to the Ribbon, select a tab. The tab you add will go 
after the tab you select.

 3. Click the Add button.

Removing items from the Ribbon
Follow these steps to remove a tab, group, or command from the Ribbon:

 1. On the right side of the Customize Ribbon tab of the PowerPoint 
Options dialog box, select the tab, group, or command you want to 
remove.

 2. Click the Remove button.

  Except for tabs you create yourself, you can’t remove tabs from the 
Ribbon. And you can’t remove a command unless you remove it from a 
group you created yourself.

Renaming tabs and groups
Follow these steps to rename a tab or group:

 1. On the right side of the Customize Ribbon tab of the PowerPoint 
Options dialog box, select the tab or group you want to rename.

 2. Click the Rename button.

  You see the Rename dialog box.

 3. Enter a new name and click OK.
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517Customizing the Ribbon

Creating new tabs and groups
Create new tabs and groups on the Ribbon for commands that are espe-
cially useful to you. Follow these steps on the Customize Ribbon tab of the 
PowerPoint Options dialog box (refer to Figure 1-1) to create a new tab or 
group:

 1. On the right side of the dialog box, display and select the name of a 
tab or group.

  Earlier in this chapter, “Displaying and selecting tab, group, and com-
mand names” explains how to select items in the PowerPoint Options 
dialog box.

 • Tab: If you’re creating a tab, select a tab name. The tab you create 
will appear after the tab you select.

 • Group: If you’re creating a group, select a group name. The group 
you create will appear after the group you select.

 2. Click the New Tab or New Group button.

  PowerPoint creates a new tab or group called “New Tab (Custom)” or 
“New Group (Custom).” If you created a tab, PowerPoint also creates a 
new group inside your new tab.

 3. Click the Rename button to give the tab, group, or both a name.

  In the Rename dialog box, enter a descriptive name and click OK. If 
you’re naming a group, the Rename dialog box gives you the opportunity 
to select an icon to help identify the group.

 4. Add groups, commands, or both to your newly made tab or group.

  For instructions, see “Adding items to the Ribbon,” earlier in this chapter.

Resetting your Ribbon customizations
If you make a hash of the Ribbon, all is not lost — you can restore the original 
settings. In the PowerPoint Options dialog box, click the Reset button (refer to 
Figure 1-1) and choose one of these commands on the drop-down list:

 ✦ Reset Only Selected Ribbon Tab: Select a tab name on the right side of 
the PowerPoint Options dialog box and choose this command to restore 
a tab to its original state.

 ✦ Reset All Customizations: Choose this command to restore the Ribbon 
in its entirety. All changes you made are reversed.

You can also remove individual tabs and groups you created if you discover 
you don’t need them. See “Removing items from the Ribbon,” earlier in this 
chapter.
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518 Customizing the Quick Access Toolbar

To load customizations from a file into PowerPoint, return to the Customize 
Ribbon or Quick Access Toolbar category of the PowerPoint Options dialog 
box, click the Import/Export button, and choose Import Customization File. 
You see the File Open dialog box. Select the file and click the Open button.

Customizing the Quick Access Toolbar
No matter where you go in PowerPoint, you see the Quick Access toolbar 
in the upper-left corner of the screen. This toolbar offers three important 
buttons — Save, Undo, and Repeat. However, which buttons appear on 
the Quick Access toolbar is entirely up to you. You can put your favorite 
buttons on the toolbar to keep them within reach. And if the Quick Access 
toolbar gets too big, you can move it below the Ribbon, as shown in Figure 
1-2. Adding buttons to and removing buttons from the Quick Access toolbar 
is, I’m happy to report, a piece of cake. And moving the toolbar below the 
Ribbon is as easy as pie.

Adding buttons to the Quick Access toolbar
Use one of these techniques to add buttons to the Quick Access toolbar:

 ✦ On the Ribbon, right-click a button you want to see on the toolbar 
and choose Add to Quick Access Toolbar on the shortcut menu (refer 
to Figure 1-2). You can add all the commands in a group to the Quick 
Access toolbar by right-clicking the group name and choosing Add to 
Quick Access Toolbar.

  ✦ Click the Customize Quick Access Toolbar button (located to the right of 
the Quick Access toolbar) and choose a button on the drop-down list. 
The list offers buttons deemed by the makers of PowerPoint the most 
likely to be placed on the Quick Access toolbar.

Exporting and importing program customizations
You can preserve your Ribbon and Quick 
Access toolbar customizations for posterity in 
a special file called an Import Customization 
file; these files have the .exportedUI file 
extension. Keep the file on hand for when you 
need it, or distribute the file to co-workers. For 
that matter, a co-worker who is proud of his or 
her customizations can send them to you in a 
file and you can load the customizations into 
your copy of PowerPoint.

To save your Ribbon and Quick Access toolbar 
customization settings in a file, start on the File 
tab, choose Options, and go to the Customize 
Ribbon or Quick Access Toolbar category of 
the PowerPoint Options dialog box. Then click 
the Import/Export button and choose Export All 
Customizations on the drop-down list. The File 
Save dialog box opens. Give the customizations 
file a name and click the Save button.
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519Customizing the Quick Access Toolbar

 ✦ On the File tab, choose Options, and select the Quick Access Toolbar 
category in the PowerPoint Options dialog box (or right-click any button 
or tab and choose Customize Quick Access Toolbar on the shortcut 
menu). You see the Quick Access Toolbar category of the PowerPoint 
Options dialog box, as shown in Figure 1-3. On the Choose Commands 
From drop-down list, select the name of the tab with the button you 
want to add to the Quick Access toolbar. Then select the button’s name 
and click the Add button.

 

Figure 1-2: 
Merely 
by right-
clicking, you 
can add a 
button to 
the Quick 
Access 
toolbar.

 

Right-click a button to add it to the toolbar

The Quick Access toolbar below the Ribbon

To restore the Quick Access toolbar to its original three buttons (Save, 
Undo, and Repeat), click the Reset button on the Quick Access Toolbar 
tab of the PowerPoint Options dialog box (refer to Figure 1-3) and choose 
Reset Only Quick Access Toolbar on the drop-down list. Choosing Reset All 
Customizations resets Ribbon customizations as well as Quick Access tool-
bar customizations.

Changing the order of buttons 
on the Quick Access toolbar
Follow these steps to change the order of buttons on the Quick Access 
toolbar:

 1. Right-click any button or tab and choose Customize Quick Access 
Toolbar.

  The Quick Access Toolbar category of the PowerPoint Options dialog 
box appears (see Figure 1-3).

 2. Select the name of a button on the right side of the dialog box and 
click the Move Up or Move Down button.
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520 Customizing the Quick Access Toolbar

 

Figure 1-3: 
Use this 
dialog box 
to add, 
remove, 
and reorder 
buttons.

 

Select a tab Select a button and click Add

 3. Repeat Step 2 until the buttons are in the right order.

 4. Click OK.

Removing buttons from the Quick Access toolbar
Use one of these techniques to remove buttons from the Quick Access 
toolbar:

 ✦ Right-click a button on the toolbar and choose Remove from Quick 
Access Toolbar on the shortcut menu.

 ✦ Right-click any button or tab and choose Customize Quick Access 
Toolbar. You see the Quick Access Toolbar category of the PowerPoint 
Options dialog box (refer to Figure 1-3). Select the button you want to 
remove on the right side of the dialog box and click the Remove button.

Placing the Quick Access toolbar 
above or below the Ribbon
The Ribbon is the stretch of ground along the top of the screen where the 
tabs and buttons are found. If your Quick Access toolbar is too large, con-
sider placing it below the Ribbon, not above it (refer to Figure 1-2). Follow 
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521Customizing the Status Bar

these instructions to place the Quick Access toolbar above or below the 
Ribbon:

 ✦ Quick Access toolbar below the Ribbon: Right-click the toolbar and, 
on the shortcut menu, choose Show Quick Access Toolbar Below the 
Ribbon. You can also click the Customize Quick Access Toolbar button 
and choose Show Below Ribbon on the drop-down list.

 ✦ Quick Access toolbar above the Ribbon: Right-click the toolbar and, 
on the shortcut menu, choose Show Quick Access Toolbar Above the 
Ribbon. You can also click the Customize Quick Access Toolbar button 
and choose Show Above Ribbon on the drop-down list.

The PowerPoint Options dialog box offers a check box called Show Quick 
Access Toolbar below the Ribbon (refer to Figure 1-3). You can select this 
check box as well to move the toolbar below the Ribbon.

Customizing the Status Bar
The status bar along the bottom of the window gives you information about 
your presentation. It tells you which slide you’re looking at and the theme 
you chose for your presentation. It also presents the View buttons, the Zoom 
to Fit button, and Zoom controls, among other amenities.

To choose for yourself what appears on the status bar, right-click it. You see 
the pop-up menu shown in Figure 1-4. By selecting and deselecting items on 
this menu, you can decide what appears on the status bar.

 

Figure 1-4: 
Right-click 
the status 
bar to 
customize it.
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522 Changing Color Schemes

Select or deselect these options to take command of the status bar:

 ✦ View Indicator: In Normal view, tells you which slide is displayed and 
how many slides are in your presentation. I see no reason for jettisoning 
this one.

 ✦ Theme: Tells you which theme you selected for your presentation.

 ✦ Number of Authors Editing: Lists how many different authors have 
worked on the presentation.

 ✦ Spell Check: Displays an icon that indicates whether spelling errors are 
found on a slide.

 ✦ Language: Lists which language has been assigned to text you select. This 
one is useful if yours is a polyglot presentation. See Book II, Chapter 4.

 ✦ Signatures: Shows whether a digital signature has been assigned to this 
presentation.

 ✦ Information Management Policy: Declares whether information rights 
management services have been applied to this presentation.

 ✦ Permissions: Shows whether only co-workers given permission can view 
or edit the presentation.

 ✦ Upload Status: Shows whether the presentation has been uploaded to a 
SharePoint site.

 ✦ Document Updates Available: Shows whether an updated edition of the 
document is available at a SharePoint site.

 ✦ View Shortcuts: Displays the Normal, Slide Sorter, Reading View, and 
Slide Show buttons. This one is essential.

 ✦ Zoom: Displays the Zoom box, the percentage reading that you can click 
to see the Zoom dialog box. This one is also essential.

 ✦ Zoom Slider: Displays the Zoom slider, which you can slide to shrink or 
enlarge slides on your screen — an essential item.

 ✦ Zoom to Fit: Displays the Zoom to Fit button in Normal view, which 
enables you to enlarge or shrink the slide such that it fits the screen and 
you can see it better.

Changing Color Schemes
Figure 1-5 shows three color schemes with which you can dress up 
PowerPoint: Blue, Silver, and Black. Which do you prefer? Follow these steps 
to choose a color scheme for PowerPoint:
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523Changing Color Schemes

 

Figure 1-5: 
Take your 
choice of 
these color 
schemes: 
Blue (top), 
Silver 
(middle), 
or Black 
(bottom).

 

  1. Go to the File tab and choose Options.

   You see the PowerPoint Options dialog box.

 2. Visit the General category.

 3. Open the Color Scheme drop-down list and choose an option.

 4. Click OK.

  How do you like your new get-up?

35_500996-bk07ch01.indd   52335_500996-bk07ch01.indd   523 4/19/10   10:55 AM4/19/10   10:55 AM



524 Book VII: PowerPoint for Power Users

35_500996-bk07ch01.indd   52435_500996-bk07ch01.indd   524 4/19/10   10:55 AM4/19/10   10:55 AM


